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1 Document Overview
This document shows the steps to successfully integrate Yaskawa drives into TIA Portal. Additionally, it shows the steps
required to quickly and easily integrate it into the PLC logic.

u Library Overview
The Yaskawa VFD PROFINET Library allows you to integrate Yaskawa drives controlled over PROFINET into TIA Portal
projects quickly and easily.
The library has function blocks that are designed to let you easily interface with the drive to decrease development time.
The library supports S7-1200 and S7-1500 controllers. There are separate libraries for 4 different versions of TIA Portal:
V15_1, V16, V17 & V18.

Note: These instructions assume that you have already created a TIA Portal project and you have already added a PLC controller to the project.

1 Document Overview
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2 Library Contents
This library contains 9 different function blocks. There are blocks for the SI-EP3 PROFINET Option card for and for the
JOHB-SMP3 Multi-Protocol Ethernet Option card. Some function blocks are only available for use on the JOHB-SMP3.

Function Block Function Block Name Drive Object Module (Telegram)
Configured in PLC

Availability
SI-EP3 JOHB-SMP3

Standard fbVFD_Yaskawa_Standard Std Tgm 1 Yes Yes
Standard + 5
Configurable fbVFD_Yaskawa_Standard + 5 PZD Std gm 1 + 5 PZD Yes Yes

Standard + 10
Configurable fbVFD_Yaskawa_Standard + 10 PZD Std Tgm 1 + 10 PZD – Yes

P-Drive fbVFD_Yaskawa_PROFIDrive Std Tgm 1 Yes Yes
P-Drive + 5

Configurable fbVFD_Yaskawa_PROFIDrive + 5 PZD Std Tgm 1 + 5 Yes Yes

P-Drive + 10
Configurable fbVFD_Yaskawa_PROFIDrive + 10 PZD Std Tgm 1 + 10 – Yes

Gateway Master <1> fbVFD_Yaskawa_Gateway_Master Gateway + 10 PZD – Yes

Gateway Slave <1> fbVFD_Yaskawa_Gateway_Slave - – Yes
P-Drive Gateway

Master <1>
fbVFD_Yaskawa_Gateway_Master_P-

Drive Gateway + 10 PZD – Yes

<1> These function blocks will only operate correctly when you install a JOHB-SMP3 on a GA800, GA700, GA500, FP605 or HV600 drive. If you
install a JOHB-SMP3 on a 1000-series drive, these function blocks will NOT operate correctly.

u Yaskawa Standard Function Blocks
• The control word uses a simple Boolean Run Forward / Run Reverse interface. (For example: Fwd Run, Rev Run, and Fault

Reset.)
• The status word uses simple Boolean status signals. (For example: Running, Ready, and Fault.)
• The frequency reference is unipolar, accepting positive values only (normally in units of 0.01 Hz).
• Can include 0, 5, or 10 configurable registers (PZDs) for additional cyclic information exchange.
• Set the Control/Status Configuration in the PLC parameters to 0: Yaskawa Specific

u Yaskawa P-Drive Function Blocks
• The control word (STW) is set up for PROFIDrive operation. (For example: Ready To Operate, Emergency Off, and Inhibit

Operation.)
• The status word (ZSW) is set up for PROFIDrive operation. (For example: Ready To Switch On, Ready To Operate, and

Fault.)
• The frequency reference is bi-polar.
• Can include 0, 5, or 10 configurable registers (PZDs) for additional cyclic information exchange.
• Set the Control/Status Configuration in the PLC parameters to 1: Yaskawa P-Drive

u Standard Gateway Function Block (Gateway Master)
• Uses the gateway feature that lets you connect one drive (Master) to a PROFINET network and use a low-speed RS-485

connection to communicate with up to 4 additional (Slave) drives.

2 Library Contents
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• The control word for the master drive uses a simple Boolean Run Forward / Run Reverse interface (For example: Fwd Run,
Rev Run and Fault Reset). The status word (ZSW) is set up for PROFIDrive operation. (For example: Ready To Switch On,
Ready To Operate, and Fault.)

• The status word uses simple Boolean status signals (For example: Running, Ready, and Fault.)
• All slave drives use a simple Boolean Run Forward / Run Reverse interface.
• Includes 10 configurable registers (PZDs) for additional cyclic information exchange with the Master Drive (only).
• Set the Control/Status Configuration in the PLC parameters to 0: Yaskawa Specific

u P-Drive Gateway Function Block (Gateway Master)
• Uses the gateway feature that lets you connect one drive (Master) to a PROFINET network and use a low-speed RS-485

connection to communicate with up to 4 additional (Slave) drives.

• The control word (STW) is set up for PROFIDrive operation. (For example: Ready To Operate, Emergency Off, and Inhibit
Operation.) The control word for the master drive uses a simple Boolean Run Forward / Run Reverse interface. (For example:
Fwd Run, Rev Run, and Fault Reset.) The status word (ZSW) is set up for PROFIDrive operation (For example: Ready To
Switch On, Ready To Operate, and Fault.)

• The status word (ZSW) is set up for PROFIDrive operation (For example: Ready To Switch On, Ready To Operate, and
Fault.)

• The frequency reference is bi-polar.
• All slave drives use a simple Boolean Run Forward / Run Reverse interface.
• Includes 10 configurable registers (PZDs) for additional cyclic information exchange with the Master Drive (only).
• Set the Control/Status Configuration in the PLC parameters to 1: Yaskawa P-Drive

u Gateway Slave Function Block
• Used with a Gateway Master Function Block (either Standard or P-Drive).
• One Gateway Slave Function block is necessary for each slave drive.
• The frequency reference is unipolar, accepting positive values only (usually in 0.01 Hz units).
• Simple Boolean Run Forward / Run Reverse interface.

2 Library Contents
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3 Import the Library Into Your Project
1. Download the most recent version of the library from the Yaskawa website at https://www.yaskawa.com/products/

drives/industrial-ac-drives/industrial-network-communication-protocols/profinet.
Note: Make sure that the library version that you download aligns with the version of Portal that you are using for development. Look

under Help > Installed Software to verify your version.
2. On the right-hand side of Portal, select the Libraries tab and expand Global libraries.
3. Right-click in the blank space in the Global libraries tab, then select Retrieve library…

3 Import the Library Into Your Project
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4. After the file explorer opens, navigate to the location where you saved the downloaded library in Step 1.
Note: If you cannot find your library in this file explorer, make sure that library version you downloaded matches the version of TIA

Portal you are using.

5. After you select the archived library, the software will ask you where you want to save the uncompressed version of
the library. Select a destination and click OK.

3 Import the Library Into Your Project
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6. Make sure that the library is shown in the Global libraries tab to confirm that you have successfully added the
library.

7. Expand the Yaskawa library folder, then expand Types, then S7-1200 / 1500.

3 Import the Library Into Your Project
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8. There are several different function blocks that can be used depending upon the telegram you want to use in your
application:

Function Block Standard Drive Object Module (Telegram)
Configured in PLC

Availability
SI-EP3 JOHB-SMP3

Standard Telegram 1
(Std Tgm 1)

fbVFD_Yaskawa_Standard 0: Yaskawa Standard
Yes Yes

fbVFD_Yaskawa_PROFIDrive 1: Yaskawa P-Drive
Standard Telegram 1

+ 5 Configurable
PZDs (Std Tgm 1 + 5

PZD)

fbVFD_Yaskawa_Standard + 5 PZD 0: Yaskawa Standard
Yes Yes

fbVFD_Yaskawa_PROFIDrive + 5 PZD 1: Yaskawa P-Drive

Standard Telegram 1
+ 10 Configurable

PZDs (Std Tgm 1 +
10)

fbVFD_Yaskawa_Standard + 10 PZD 0: Yaskawa Standard
– Yes

fbVFD_Yaskawa_PROFIDrive + 10 PZD 1: Yaskawa P-Drive

Gateway Master
Telegram + 10

Configurable PZDs
(Gateway + 10 PZD)

fbVFD_Yaskawa_Gateway_Master 0: Yaskawa Standard

– YesfbVFD_Yaskawa_Gateway_Master_P-
Drive 1: Yaskawa P-Drive

fbVFD_Yaskawa_Gateway_Slave n/a

Below shows how the function blocks are organized within TIA Portal:

3 Import the Library Into Your Project
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9. Depending on the telegram you want to use in your application, drag the appropriate block from your global libraries
to Program blocks in the left-hand side of Portal to import the library into your project.

3 Import the Library Into Your Project
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4 Add the Drive to Your Hardware Configuration
1. Download the appropriate GSD (.GSDML) file for the option card:

JOHB-SMP3: Most installations will use: GSDML-V2.4-Yaskawa-JOHB-SMP3-20220222
https://www.yaskawa.com/MPE
SI-EP3: Most installations will use: GSDML-V2.3-Yaskawa-SIEP3-20150604
https://www.yaskawa.com/products/drives/industrial-ac-drives/industrial-network-communication-protocols/profinet

2. Select Options, then Manage General Station Description Files (GSD) to add the .GSDML file.
3. Open the hardware configuration of your project in the Network View.
4. Drag the applicable option card into your hardware configuration. (Examples shown below use the JOHB-SMP3, but

the procedure is the same for the SI-EP3).

5. Drag the existing network onto the green square on the JOHB-SMP3 (DP-NORM) icon to add the drive to the
appropriate PROFINET network.

Note: Make sure to assign your drive to the correct PLC as its IO controller. In the figure below, the drive is assigned to PLC_1 as
indicated by the blue text.

6. Double-click on the drive to enter the Device view.

4 Add the Drive to Your Hardware Configuration
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7. Navigate to your hardware catalog and expand Module > Drive Object. Select the telegram that you want to use for
your application, then drag it into the first blank row on the Device overview tab. In most cases, this should align with
the function block that you added to the project in Step 9 on page 11.

8. Specify whether you are using a Standard Yaskawa telegram or the PROFIDrive telegram. Click on the telegram that
was just added in the Device overview window, then go to Properties > General > Module Parameters and select
either “Yaskawa Standard” or “Yaskawa P-Drive” (PROFIDrive) in the drop-down list to complete adding the drive to
your hardware configuration.

4 Add the Drive to Your Hardware Configuration
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5 Connect the Drive to the PROFINET Network
1. Connect one of the RJ-45 ports on the option card to the PROFINET network.

In the Project Tree, expand Online Access, then find the network interface that is being used to connect the PC to
the PLC and click Update accessible devices.

2. After the search is complete, click on the newly found drive and then select Online & diagnostics. If the option card
does not yet have a station name assigned, it will show up as "accessible device" followed by the [MAC address].

Note: Yaskawa PROFINET option cards will start with a MAC address of "00-20-B5"

5 Connect the Drive to the PROFINET Network
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3. Assign the drive a PROFINET device name.
Expand Functions, then click on Assign name. In the box labeled PROFINET device name, set / change the station
name for the drive. Then click Assign name.

5 Connect the Drive to the PROFINET Network
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4. Modify the hardware configuration to set the assigned IP address of the drive.
In the Devices & networks window, click on the Network view tab [1], then click on the drive [2].
Select the Properties tab [3], then select the General tab [4], then expand PROFINET interface [X1], and select
Ethernet addresses [5]. Make sure that the Set IP address in the project radio button [6] is selected, and enter the
IP address you assigned to the drive in Step 3.
In the PROFINET area underneath the IP address, uncheck Generate PROFINET device name automatically [7]
and enter the PROFINET device name [8] you set in Step 3.

5. Recompile and download the updated hardware configuration to verify a successful connection. If successful, both
“NS” and “MS” LEDs on the drive will be lit.

5 Connect the Drive to the PROFINET Network
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6 Add the Yaskawa Function Block to the Program
1. Drag the block from the Project tree into a rung of ladder to add an instance of the function block into the program.

2. After you drag the block into a rung, you will be prompted to declare the block as either single or multi-instance.
Consider the existing architecture of your code before you make your selection.
When you declare the function block as single instance, it will create a global data block that will allow you to access
the inputs and outputs of the function block anywhere in the program.
When you declare the function block as multi-instance, it can improve the organization of your code when you use
many drives throughout the project.

3. Choose a name for the instance memory, considering existing naming conventions. If no naming conventions already
exist, consider the following:
. Example Single Instance Name: dbIns_Drive1
. Example Multi-Instance Name: #VFD_Drive1

6 Add the Yaskawa Function Block to the Program
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7 Link the Yaskawa Function Block to the Applicable Drive

u Using S7-1200/1500 PLCs
The 1200/1500 version of the block interfaces with the drive using the hardware identifier number of the telegram.

1. To find the hardware identifier number for the telegram, navigate back to the Device view for the drive by double
clicking on it from the Network view.
Click on the telegram in the Device overview tab and then click on Properties > General > System Constants to
find the hardware identifier number.

2. The TIA Portal automatically creates tags for all hardware identifier numbers. To locate the hardware identifier number
for a drive, navigate to Default Tag Table > System Constants. Here, there will be a tag of datatype Hw_SubModule
that will have the “Drive name” + “~” + “Telegram name”.
In our example it has the name is JOHB-SMP3~Std_Tgm_1_1. Use CTRL + C to copy this entire tag name onto the
clipboard for use later. Make sure that this number matches the number in Step 1.

7 Link the Yaskawa Function Block to the Applicable Drive
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3. After you add the Yaskawa function block into your project, you must link the input hwIODriveTelgram to the tag located
in the previous step.
Use CTRL + V to paste the tag name from the clipboard and press ENTER. To confirm the tag is correct, ensure that
the green number above the tag matches the value in Step 1.

Note: The tag name needs to be in quotations to register as a tag and show the green number.

7 Link the Yaskawa Function Block to the Applicable Drive
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8 Example Block Usage
This section shows an example use case for the Yaskawa Standard telegram block.
In the example system, the drive takes start, stop, reset and speed setpoint commands from an HMI. The start and stop buttons
originate from outside of the calling function block and are written to the local static variable #bRunForward, which is then
an input to the Yaskawa function block.
This particular drive is only being commanded to run forward, so the bInReverseRun input is given a permanent “false”.
The frequency reference fFrequencyRef (controlled from the HMI), is converted from a 0.00 - 60.00 real value to a 0 - 6000
integer value, which the function block sends to the drive. The outputs of the function block write drive status variables to a
few local variables: #bDriveReady, #bDriveRunning and #bDriveFaulted
You can use these variables to monitor or control related logic elsewhere in the program. For example, in Network 1, the
variable #bDriveFaulted is used to unlatch the forward Run command when the drive encounters a fault.
Additionally, since this block is declared as single instance, you can globally access its inputs and outputs. For example:
"fbVFD_Yaskawa_Standard_DB".bOutFault, "fbVFD_Yaskawa_Standard_DB".bOutRunning, and
"fbVFD_Yaskawa_Standard_DB".bOutReady.”

8 Example Block Usage
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9 Gateway Program Example
The gateway function lets you connect one PROFINET option to a Master Drive and use the built-in RS-485 connection to
connect that Master drive to a maximum of four Slave drives. The gateway function is available when you use a JOHB-SMP3
on a GA800, GA700, GA500, or FP605 drive. Refer to the drive Technical Manual for more information about how to set this
up.

Some of the following steps are abbreviated; see the previous example in this document for details about where to find the
various menus and other information.

9 Gateway Program Example
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PLC programming example for a Master and 4 Slave drives:
1. On the JOHB-SMP3 option card, use the Gateway + 10PZD drive object module from the hardware catalog.

2. Create logic to handle the Run commands for the master and 4 slave drives. In this example, the master and each of
the slave drives have their own Run and Stop push buttons on an HMI. There is also an interlock for each drive that
will remove the Run command if a particular drive has a fault.

9 Gateway Program Example
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3. Create logic to scale the frequency references for the master and all four slave drives. In this example, the frequency
references come across from the HMI as a “real” values and are converted to the properly scaled “int” values used
by the Yaskawa function blocks.

4. From the Yaskawa Function Block Library, drag the Yaskawa > Types > S7-1200/1500 > JOHB-SMP3(only) >
fbVFD_Yaskawa_Gateway_Master function block into the project. This function block will control only the master
drive.
Set the hwlODriveTelegram to the value copied from the JOHB-SMP3 configuration (Device View > Gateway + 10
PZD_1 > System Constants).
Set the value of wInNumOfSlaves to the number of slave drives in the project. For this example, this is set to the
maximum value of 4.
Connect other signals as needed to the function block.

9 Gateway Program Example
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5. From the Yaskawa library, drag 4 of the Yaskawa > Types > S7-1200/1500 > JOHB-SMP3(only) >
fbVFD_Yaskawa_Gateway_Slave function blocks into the project. These function blocks will control each of the slave
drives.
Set the hwlODriveTelegram to the SAME value as copied from the JOHB-SMP3 configuration (Device View >
Gateway + 10 PZD_1 > System Constants).
Set the value of wInSlaveNumber for each of the 4 slave drives.
Connect other signals as necessary.

9 Gateway Program Example
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10 Monitor Drive Information
Often it will be useful to monitor the data the drive is exchanging with the PLC for troubleshooting and commissioning. There
two primary ways of accomplishing this:
1. Monitoring the instance data of the block
2. Monitoring and changing variables from a watch table
To monitor the instance data of the block:

1. Locate and open the instance data block for the function block controller the drive.
2. Click Monitor all to view the online information.
3. View the live information in the Monitor value column.
4. To modify the values (for example, wInFrequencyRef or bInForwardRun), double-click on the value in the Monitor

value column.

To monitor and change variables from a watch table:
1. In the project tree, navigate to Watch and force tables.
2. Add a new watch table.
3. Add the instance data variables that you want to monitor to the watch table.

10 Monitor Drive Information
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4. Click the monitor all icon (shown in the figure below with the glasses) to view the live values in the “Monitor value”
column.

5. To easily add all the instance data to the watch table, click the bottom-right corner of a single item and drag it toward
the bottom of the screen.

6. To modify the values (for example, wInFrequencyRef or bInForwardRun), enter the desired value in the Modify
value column. Click the Modify all selected values once and now button (the button with a lightning bolt with an “!”
next to it).

10 Monitor Drive Information
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11 Detailed Block Tables

u S7-1200/1500 Blocks
n fbVFD_Yaskawa_Standard

Input Variables Type Description
wInFrequencyRef Word Setpoint frequency (0-6000)

hwIODriveTelegram HW_IO Name of telegram begin used with Yaskawa drive
bInForwardRun Bool Command forward run
bInReverseRun Bool Command reverse run
bInFaultReset Bool Command fault reset
bInFaultEF0 Bool Command EF0 Drive Fault

bInDI1 Bool Command DI1
bInDI2 Bool Command DI2
bInDI3 Bool Command DI3
bInDI4 Bool Command DI4
bInDI5 Bool Command DI5
bInDI6 Bool Command DI6
bInDI7 Bool Command DI7
bInDI8 Bool Command DI8
bInDI9 Bool Command DI9
bInDI10 Bool Command DI10
bInDI11 Bool Command DI11
bInDI12 Bool Command DI12

Output Variables Type Description
wOutFrequency Word Current output frequency

bOutReady Bool Drive is in ready state
bOutRunning Bool Running in forward direction
bOutReverse Bool Running in reverse direction

bOutFault Bool Fault signal is active
bOutAlarm Bool Alarm signal is active

bOutZeroSpeed Bool At zero speed
bOutAtSpeed Bool At setpoint speed

bOutResetActive Bool Reset signal is active
bOutNetReference Bool Frequency setpoint from PROFINET
bOutNetControl Bool Drive is being controlled from PROFINET commands.
bOutZeroServo Bool Zero Servo completed
bOutOPEFault Bool oPE (Parameter Setting) Fault
bOutDuringUV Bool Drive in Undervoltage Condition
bOut2ndMotor Bool 2nd Motor Selected

n fbVFD_Yaskawa_Standard + 5 PZD
Input Variables Type Description
wInFrequencyRef Word Setpoint frequency (0-6000)

hwIODriveTelegram HW_IO Name of telegram begin used with Yaskawa drive
bInForwardRun Bool Command forward run
bInReverseRun Bool Command reverse run
bInFaultReset Bool Command fault reset
bInFaultEF0 Bool Command EF0 Drive Fault

bInDI1 Bool Command DI1

11 Detailed Block Tables
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Input Variables Type Description
bInDI2 Bool Command DI2
bInDI3 Bool Command DI3
bInDI4 Bool Command DI4
bInDI5 Bool Command DI5
bInDI6 Bool Command DI6
bInDI7 Bool Command DI7
bInDI8 Bool Command DI8
bInDI9 Bool Command DI9
bInDI10 Bool Command DI10
bInDI11 Bool Command DI11
bInDI12 Bool Command DI12

iInCmdPZD1 Int PLC to Drive Parameter 1 Command Value
InCmdPZD2 Int PLC to Drive Parameter 2 Command Value
iInCmdPZD3 Int PLC to Drive Parameter 3 Command Value
iInCmdPZD4 Int PLC to Drive Parameter 4 Command Value
iInCmdPZD5 Int PLC to Drive Parameter 5 Command Value

Output Variables Type Description
wOutFrequency Word Current output frequency

bOutReady Bool Drive is in ready state
bOutRunning Bool Running in forward direction
bOutReverse Bool Running in reverse direction

bOutFault Bool Fault signal is active
bOutAlarm Bool Alarm signal is active

bOutZeroSpeed Bool At zero speed
bOutAtSpeed Bool At setpoint speed

bOutResetActive Bool Reset signal is active
bOutNetReference Bool Frequency setpoint from PROFINET
bOutNetControl Bool Drive is being controlled from PROFINET commands.
bOutZeroServo Bool Zero Servo Completed
bOutOPEFault Bool oPE (Parameter Setting) Fault
bOutDuringUV Bool Drive in Undervoltage Condition
bOut2ndMotor Bool 2nd Motor Selected
iOutMonPZD1 Int Drive to PLC Parameter 1 Received Value
iOutMonPZD2 Int Drive to PLC Parameter 2 Received Value
iOutMonPZD3 Int Drive to PLC Parameter 3 Received Value
iOutMonPZD4 Int Drive to PLC Parameter 4 Received Value
iOutMonPZD5 Int Drive to PLC Parameter 5 Received Value

n fbVFD_Yaskawa_Standard + 10PZD
Input Variables Type Description
wInFrequencyRef Word Setpoint frequency (0-6000)

hwIODriveTelegram HW_IO Name of telegram begin used with Yaskawa drive
bInForwardRun Bool Command forward run
bInReverseRun Bool Command reverse run
bInFaultReset Bool Command fault reset
bInFaultEF0 Bool Command EF0 Drive Fault

bInDI1 Bool Command DI1
bInDI2 Bool Command DI2
bInDI3 Bool Command DI3
bInDI4 Bool Command DI4

11 Detailed Block Tables
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Input Variables Type Description
bInDI5 Bool Command DI5
bInDI6 Bool Command DI6
bInDI7 Bool Command DI7
bInDI8 Bool Command DI8
bInDI9 Bool Command DI9
bInDI10 Bool Command DI10
bInDI11 Bool Command DI11
bInDI12 Bool Command DI12

iInCmdPZD1 Int PLC to Drive Parameter 1 Command Value
InCmdPZD2 Int PLC to Drive Parameter 2 Command Value
iInCmdPZD3 Int PLC to Drive Parameter 3 Command Value
iInCmdPZD4 Int PLC to Drive Parameter 4 Command Value
iInCmdPZD5 Int PLC to Drive Parameter 5 Command Value
iInCmdPZD6 Int PLC to Drive Parameter 6 Command Value
InCmdPZD7 Int PLC to Drive Parameter 7 Command Value
iInCmdPZD8 Int PLC to Drive Parameter 8 Command Value
iInCmdPZD9 Int PLC to Drive Parameter 9 Command Value
iInCmdPZD10 Int PLC to Drive Parameter 10 Command Value

Output Variables Type Description
wOutFrequency Word Current output frequency

bOutReady Bool Drive is in ready state
bOutRunning Bool Running in forward direction
bOutReverse Bool Running in reverse direction

bOutFault Bool Fault signal is active
bOutAlarm Bool Alarm signal is active

bOutZeroSpeed Bool At zero speed
bOutAtSpeed Bool At setpoint speed

bOutResetActive Bool Reset signal is active
bOutNetReference Bool Frequency setpoint from PROFINET
bOutNetControl Bool Drive is being controlled from PROFINET commands.
bOutZeroServo Bool Zero Servo Completed
bOutOPEFault Bool oPE (Parameter Setting) Fault
bOutDuringUV Bool Drive in Undervoltage Condition
bOut2ndMotor Bool 2nd Motor Selected
iOutMonPZD1 Int Drive to PLC Parameter 1 Received Value
iOutMonPZD2 Int Drive to PLC Parameter 2 Received Value
iOutMonPZD3 Int Drive to PLC Parameter 3 Received Value
iOutMonPZD4 Int Drive to PLC Parameter 4 Received Value
iOutMonPZD5 Int Drive to PLC Parameter 5 Received Value
iOutMonPZD6 Int Drive to PLC Parameter 6 Received Value
iOutMonPZD7 Int Drive to PLC Parameter 7 Received Value
iOutMonPZD8 Int Drive to PLC Parameter 8 Received Value
iOutMonPZD9 Int Drive to PLC Parameter 9 Received Value
iOutMonPZD10 Int Drive to PLC Parameter 10 Received Value

n fbVFD_Yaskawa_PROFIDrive
Input Variables Type Description

iInFrequencySetPoint Int Setpoint frequency (-6000-6000)
hwIODriveTelegram HW_IO Name of telegram begin used with Yaskawa drive

bInOnOff1 Bool Proceed to ready operate

11 Detailed Block Tables
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Input Variables Type Description
bInOff2 Bool Continue operation (OFF2 inactive)
bInOff3 Bool Continue operation (OFF3 inactive)

bInOperationEnable Bool Proceed to ENABLE OPERATION
bInRampOutZero Bool Normal operation (Stop inactive)

bInRampHold Bool Normal operation (Force ramp function generator inactive)
bInRampInZero Bool Normal operation (Force ramp function generator inactive)

bInReset Bool Reset signal enable
bInRemoteCMD Bool Network control enabled

Output Variables Type Description
iOutFrequency Int Drive current output frequency

bOutRdyOn Bool ZSW, Bit 0: Ready to switch on
bOutRdyRun Bool ZSW, Bit 1: Ready to operate
bOutRdyRef Bool ZSW, Bit 2: Enable operation

bOutFault Bool ZSW, Bit 3: Fault present
bOutOff2STA Bool ZSW, Bit 4: OFF2 inactive
bOutOff3STA Bool ZSW, Bit 5: OFF3 inactive

bOutSwcOnInhib Bool ZSW, Bit 6: SWITCH-ON INHIBIT active
bOutAlarm Bool ZSW, Bit 7: Warning/alarm

bOutSpeedError Bool ZSW, Bit 8: Not at setpoint speed
bOutRemote Bool ZSW, Bit 9: Drive control location: REMOTE

bOutAtSetpoint Bool ZSW, Bit 10: Measured drive frequency is equal to setpoint with tolerances
bOutSafeTorqOff Bool ZSW, Bit 14: Safe Torque Off Alarm (JOHB-SMP3 Only)

n fbVFD_Yaskawa_PROFIDrive + 5 PZD
Input Variables Type Description

iInFrequencySetPoint Int Setpoint frequency (-6000-6000)
hwIODriveTelegram HW_IO Name of telegram begin used with Yaskawa drive

bInOnOff1 Bool STW, Bit 0: Proceed to ready operate
bInOff2 Bool STW, Bit 1: Continue operation (OFF2 inactive)
bInOff3 Bool STW, Bit 2: Continue operation (OFF3 inactive)

bInOperationEnable Bool STW, Bit 3: Proceed to ENABLE OPERATION
bInRampOutZero Bool STW, Bit 4: Normal operation (Stop inactive)

bInRampHold Bool STW, Bit 5: Normal operation (Force ramp function generator inactive)
bInRampInZero Bool STW, Bit 6: Normal operation (Force ramp function generator inactive)

bInReset Bool STW, Bit 7: Reset signal enable
bInRemoteCMD Bool STW, Bit 10: Network control enabled

iInCmdPZD1 Int PLC to Drive Parameter 1 Command Value
iInCmdPZD2 Int PLC to Drive Parameter 2 Command Value
iInCmdPZD3 Int PLC to Drive Parameter 3 Command Value
iInCmdPZD4 Int PLC to Drive Parameter 4 Command Value
iInCmdPZD5 Int PLC to Drive Parameter 5 Command Value

Output Variables Type Description
iOutFrequency Int Drive current output frequency

bOutRdyOn Bool Ready to switch on
bOutRdyRun Bool Ready to operate
bOutRdyRef Bool Enable operation

bOutFault Bool Fault present
bOutOff2STA Bool OFF2 inactive
bOutOff3STA Bool OFF3 inactive
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Output Variables Type Description
bOutSwcOnInhib Bool SWITCH-ON INHIBIT active

bOutAlarm Bool Warning/alarm
bOutSpeedError Bool Not at setpoint speed

bOutRemote Bool Drive control location: REMOTE
bOutAtSetpoint Bool Measured drive frequency is equal to setpoint with tolerances

bOutSafeTorqOff Bool Safe Torque Off Alarm (JOHB-SMP3 Only)
iOutMonPZD1 Int Drive to PLC Parameter 1 Received Value
iOutMonPZD2 Int Drive to PLC Parameter 2 Received Value
iOutMonPZD3 Int Drive to PLC Parameter 3 Received Value
iOutMonPZD4 Int Drive to PLC Parameter 4 Received Value
iOutMonPZD5 Int Drive to PLC Parameter 5 Received Value

n fbVFD_Yaskawa_PROFIDrive + 10 PZD
Input Variables Type Description

iInFrequencySetPoint Int Setpoint frequency (-6000-6000)
hwIODriveTelegram HW_IO Name of telegram begin used with Yaskawa drive

bInOnOff1 Bool STW, Bit 0: Proceed to ready operate
bInOff2 Bool STW, Bit 1: Continue operation (OFF2 inactive)
bInOff3 Bool STW, Bit 2: Continue operation (OFF3 inactive)

bInOperationEnable Bool STW, Bit 3: Proceed to ENABLE OPERATION
bInRampOutZero Bool STW, Bit 4: Normal operation (Stop inactive)

bInRampHold Bool STW, Bit 5: Normal operation (Force ramp function generator inactive)
bInRampInZero Bool STW, Bit 6: Normal operation (Force ramp function generator inactive)

bInReset Bool STW, Bit 7: Reset signal enable
bInRemoteCMD Bool STW, Bit 10: Network control enabled

iInCmdPZD1 Int PLC to Drive Parameter 1 Command Value
iInCmdPZD2 Int PLC to Drive Parameter 2 Command Value
iInCmdPZD3 Int PLC to Drive Parameter 3 Command Value
iInCmdPZD4 Int PLC to Drive Parameter 4 Command Value
iInCmdPZD5 Int PLC to Drive Parameter 5 Command Value
iInCmdPZD6 Int PLC to Drive Parameter 6 Command Value
iInCmdPZD7 Int PLC to Drive Parameter 7 Command Value
iInCmdPZD8 Int PLC to Drive Parameter 8 Command Value
iInCmdPZD9 Int PLC to Drive Parameter 9 Command Value
iInCmdPZD10 Int PLC to Drive Parameter 10 Command Value

Output Variables Type Description
iOutFrequency Int Drive current output frequency

bOutRdyOn Bool Ready to switch on
bOutRdyRun Bool Ready to operate
bOutRdyRef Bool Enable operation

bOutFault Bool Fault present
bOutOff2STA Bool OFF2 inactive
bOutOff3STA Bool OFF3 inactive

bOutSwcOnInhib Bool SWITCH-ON INHIBIT active
bOutAlarm Bool Warning/alarm

bOutSpeedError Bool Not at setpoint speed
bOutRemote Bool Drive control location: REMOTE

bOutAtSetpoint Bool Measured drive frequency is equal to setpoint with tolerances
bOutSafeTorqOff Bool Safe Torque Off Alarm (JOHB-SMP3 Only)

iOutMonPZD1 Int Drive to PLC Parameter 1 Received Value
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Output Variables Type Description
iOutMonPZD2 Int Drive to PLC Parameter 2 Received Value
iOutMonPZD3 Int Drive to PLC Parameter 3 Received Value
iOutMonPZD4 Int Drive to PLC Parameter 4 Received Value
iOutMonPZD5 Int Drive to PLC Parameter 5 Received Value
iOutMonPZD6 Int Drive to PLC Parameter 6 Received Value
iOutMonPZD7 Int Drive to PLC Parameter 7 Received Value
iOutMonPZD8 Int Drive to PLC Parameter 8 Received Value
iOutMonPZD9 Int Drive to PLC Parameter 9 Received Value
iOutMonPZD10 Int Drive to PLC Parameter 10 Received Value

n fbVFD_Yaskawa_Gateway_Master
Input Variables Type Description

hwIODriveTelegram HW_IO Name of telegram begin used with Yaskawa drive
wInNumOfSlaves Int Number of slave drives connected to the master
wInFrequencyRef Word Setpoint frequency (0-6000)
bInForwardRun Bool Command forward run
bInReverseRun Bool Command reverse run
bInFaultReset Bool Command fault reset
bInFaultEF0 Bool Command EF0 Drive Fault

bInDI1 Bool Command DI1
bInDI2 Bool Command DI2
bInDI3 Bool Command DI3
bInDI4 Bool Command DI4
bInDI5 Bool Command DI5
bInDI6 Bool Command DI6
bInDI7 Bool Command DI7
bInDI8 Bool Command DI8
bInDI9 Bool Command DI9
bInDI10 Bool Command DI10
bInDI11 Bool Command DI11
bInDI12 Bool Command DI12

iInCmdPZD1 Int PLC to Drive Parameter 1 Command Value
InCmdPZD2 Int PLC to Drive Parameter 2 Command Value
iInCmdPZD3 Int PLC to Drive Parameter 3 Command Value
iInCmdPZD4 Int PLC to Drive Parameter 4 Command Value
iInCmdPZD5 Int PLC to Drive Parameter 5 Command Value
iInCmdPZD6 Int PLC to Drive Parameter 6 Command Value
InCmdPZD7 Int PLC to Drive Parameter 7 Command Value
iInCmdPZD8 Int PLC to Drive Parameter 8 Command Value
iInCmdPZD9 Int PLC to Drive Parameter 9 Command Value
iInCmdPZD10 Int PLC to Drive Parameter 10 Command Value

Output Variables Type Description
wOutFrequency Word Current output frequency

bOutReady Bool Drive is in ready state
bOutRunning Bool Running in forward direction
bOutReverse Bool Running in reverse direction

bOutFault Bool Fault signal is active
bOutAlarm Bool Alarm signal is active

bOutZeroSpeed Bool At zero speed
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Output Variables Type Description
bOutAtSpeed Bool At setpoint speed

bOutResetActive Bool Reset signal is active
bOutNetReference Bool Frequency setpoint from PROFINET
bOutNetControl Bool Drive is being controlled from PROFINET commands.
bOutZeroServo Bool Zero Servo Completed
bOutOPEFault Bool oPE (Parameter Setting) Fault
bOutDuringUV Bool Drive in Undervoltage Condition
bOut2ndMotor Bool 2nd Motor Selected
iOutMonPZD1 Int Drive to PLC Parameter 1 Received Value
iOutMonPZD2 Int Drive to PLC Parameter 2 Received Value
iOutMonPZD3 Int Drive to PLC Parameter 3 Received Value
iOutMonPZD4 Int Drive to PLC Parameter 4 Received Value
iOutMonPZD5 Int Drive to PLC Parameter 5 Received Value
iOutMonPZD6 Int Drive to PLC Parameter 6 Received Value
iOutMonPZD7 Int Drive to PLC Parameter 7 Received Value
iOutMonPZD8 Int Drive to PLC Parameter 8 Received Value
iOutMonPZD9 Int Drive to PLC Parameter 9 Received Value
iOutMonPZD10 Int Drive to PLC Parameter 10 Received Value

n fbVFD_Yaskawa_Gateway_Slave
Input Variables Type Description

hwIODriveTelegram HW_IO Name of telegram begin used with Gateway Master drive
iInSlaveNumber Int Slave number (1 ~ 4)

wInFrequencyRef Int Setpoint frequency (0-6000)
bInForwardRun Bool Slave drive command forward run
bInReverseRun Bool Slave drive command reverse run

bInExternalFault Bool Slave drive command EF0 Drive Fault
bInFaultReset Bool Slave drive command fault reset
bInComRef Bool Force slave drive to use PROFINET frequency reference
bInComCtrl Bool Force slave drive to use PROFINET run/stop commands

Output Variables Type Description
wOutFrequency Word Slave drive output frequency
bOutRunning Bool Slave drive is running
bOutReverse Bool Slave drive is running in reverse
bOutReady Bool Slave drive is ready
bOutFault Bool Slave drive fault signal is active

bOutFreqCmdFlt Bool Slave Drive Upper/Lower Limit Fault
bOutNoResponse Bool Slave Drive Response has timed out
bOutCommError Bool Slave Drive detected a fault

bNoResponse10Times Bool Slave Drive fault has occurred from a slave 10 consecutive times
bOutBroadcastAtRun Bool Slave Drive operates as specified by the broadcast message command

bOutComErrorMaster Bool Slave Drive cannot communicate with the master because of a communications
error

bOutComRef Bool Slave Drive uses PROFINET frequency reference
bOutComCtrl Bool Slave Drive uses PROFINET run/stop commands
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n fbVFD_Yaskawa_Gateway_Master_P-Drive
Input Variables Type Description

iInFrequencySetPoint Int Setpoint frequency (-6000 - 6000)
hwIODriveTelegramHW_IO HW_IO Name of telegram being used with Yaskawa drive

bInOff1Bool Bool Proceed to ready operate
bInOff2 Bool Continue operation (OFF2 inactive)
bInOff3 Bool Continue operation (OFF3 inactive)

bInOperationEnable Bool Proceed to ENABLE OPERATION
bInRampOutZero Bool Normal operation (Stop inactive)

bInRampHold Bool Normal operation (Force ramp function generator inactive)
bInRampInZero Bool Normal operation (Force ramp function generator inactive)

bInReset Bool Reset signal enable
bInRemoteCMD Bool Network control enabled

iInCmdPZD1 Int PLC to Drive Parameter 1 Command Value
InCmdPZD2 Int PLC to Drive Parameter 2 Command Value
iInCmdPZD3 Int PLC to Drive Parameter 3 Command Value
iInCmdPZD4 Int PLC to Drive Parameter 4 Command Value
iInCmdPZD5 Int PLC to Drive Parameter 5 Command Value
iInCmdPZD6 Int PLC to Drive Parameter 6 Command Value
InCmdPZD7 Int PLC to Drive Parameter 7 Command Value
iInCmdPZD8 Int PLC to Drive Parameter 8 Command Value
iInCmdPZD9 Int PLC to Drive Parameter 9 Command Value
iInCmdPZD10 Int PLC to Drive Parameter 10 Command Value

Output Variables Type Description
iOutFrequency Int Drive current output frequency

bOutRdyOn Bool ZSW, Bit 0: Ready to switch on
bOutRdyRun Bool ZSW, Bit 1: Ready to operate
bOutRdyRef Bool ZSW, Bit 2: Enable operation

bOutFault Bool ZSW, Bit 3: Fault present
bOutOff2STA Bool ZSW, Bit 4: OFF2 inactive
bOutOff3STA Bool ZSW, Bit 5: OFF3 inactive

bOutSwcOnInhib Bool ZSW, Bit 6: SWTICH-ON INHIBIT active
bOutAlarm Bool ZSW, Bit 7: Warning/alarm

bOutSpeedError Bool ZSW, Bit 8: Not at setpoint speed
bOutRemote Bool ZSW, Bit 9: Drive control location: REMOTE

bOutAtSetpoint Bool ZSW, Bit 10: Measured drive frequency is equal to setpoint with tolerances
bOutSafeTorqOff Bool Safe Torque Off Alarm

iOutMonPZD1 Int Drive to PLC Parameter 1 Received Value
iOutMonPZD2 Int Drive to PLC Parameter 2 Received Value
iOutMonPZD3 Int Drive to PLC Parameter 3 Received Value
iOutMonPZD4 Int Drive to PLC Parameter 4 Received Value
iOutMonPZD5 Int Drive to PLC Parameter 5 Received Value
iOutMonPZD6 Int Drive to PLC Parameter 6 Received Value
iOutMonPZD7 Int Drive to PLC Parameter 7 Received Value
iOutMonPZD8 Int Drive to PLC Parameter 8 Received Value
iOutMonPZD9 Int Drive to PLC Parameter 9 Received Value
iOutMonPZD10 Int Drive to PLC Parameter 10 Received Value
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Revision History
The revision dates and the numbers of the revised manuals appear on the bottom of the back cover.

Date of Publication Revision
Number Section Revised Content

February 2023 <2> 2, 4, and 9 Updated to include the Multi-Protocol Ethernet Card (JOHB-SMP3).
September 2018 <1> – Typographical error corrections.

July 2018 – – First Release.
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